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Uvod 

AutoCAD je projektantska 2D i 3D platforma koja automatizuje zadatke koji su 
pred vama i obezbjeđuje digitalne alatke tako da se možete usredsrediti na projektovanje 
a ne na sam softver. To je najmoćniji softverski proizvod za crtanje i projektovanje na 
personalnim računarima. AutoCAD 2006 je dosad najbrža i za rad najugodnija verzija 
AutoCAD-a. 

Kako je rad uređen 

 Dio I: Osnove AutoCAD-a  
 Omogućiće vam da počnete da crtate, kroz objašnjenja kako da započnete crtež, 
koristite komande, zadate koordinate i započnete crtež. 

 Dio II: Crtanje u dvije dimenzije 
 Objašnjene su sve komande i postupci za crtanje i doradu crteža u ravni. Posebna 
pažnja je istaknuta na mogućnost upravljanja procesom crtanja pomoću slojeva,  
zumiranja i pomjeranja crteža. 

 Dio III: Crtanje u tri dimenzije 
 Data su osnovna objašnjenja o crtanju i prikazivanju crteža u tri dimenzije. 
Opisane su i mogućnosti prikazivanja 3D crteža pomoću sakrivanja nevidljivih linija, 
sjenčenja i rasterizacije. 

 Dio IV: Organizovanje crteža i rad s njima 
 U ovom dijelu opisane su mogućnosti povezivanja AutoCAD-a sa drugim 
programima širom svijeta, rad s crtežima i drugim aplikacijama. 
 

Vježbanja 

 Radi lakšeg učenja i savladavanja alata koji su opisani u maturskom radu, pored 
teksta tu se nalazi i veliki broj animacija. Većina animacija se otvara klikom na Hyperlink 
– Vidi Primjer ( u tom slučaju vam se otvara nova Web stranica koja sadrži gif. 
animaciju pomenutog vježbanja ) , dok se određen broj animacija nalazi neposredno 
ispod teksta. To je zbog toga da stranice ne bi zauzimale puno memorije jer bi u tom 
slučaju bile teške za otvaranje preko interneta. 
 Rad je organizovan tako da se s jednostavnih pitanja prelazi na sve složenija. Ako 
se prvi put susrećete s AutoCAD-om obavezno više pažnje posvetite prvom i drugom 
dijelu jer u njima se nalazi osnova koju morate da znate ako želilte da koristite AutoCAD. 
Svaka vježba je cjelina za sebe pa neke možete i da preskočite. Sve vježbe su odrađene 
prema uputstvu literature, međutim zbog različitosti hardversko-softverskih konfiguracija 
nisam u mogućnosti da garantujem da će sve animacije da rade kao u primjeru. 

napomena: Elektronski dio maturskog rad je opsirniji. U pisanoj formi data su samo 
osnovna objašnjenja pojedinih poglavlja. 
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Dio I: Osnove AutoCAD-a 

Iz ovih pet poglavlja naučićete sve što treba da biste počeli da crtate u AutoCAD-u. 
Početniku su ova poglavlja neophodna. 

Poglavlje 1: Počinjemo da crtamo 

Upoznavanje sa AutoCAD-om 

AutoCAD firme Autodesk je je najčešće korišten program za tehničko crtanje - 
registrovano je više od 3 miliona njegovih korisnika. Među komanijama koje proizvode 
softver Autodesk je na 4. mjestu u svijetu po veličini. Prema Autodesku akronim CAD 
označava projektovanje pomoću računara (engl. computer-aided design). 

AutoCAD u verziji DOS, pojavio se 1982. godine. Bio je to prvi značajniji CAD 
program koji je mogao da radi na personalnim računarima. Uspjeh AutaCAD-a se 
pripisuje njegovojnjegovoj čuvenoj otvorenoj arhitekturi - veliki dio njegovog izvornog 
koda predstavlja običan tekst koji korisnik lako može da prilagodi svojim potrebama. 
Podrška programskom jeziku AutoLISP, a sada i jeziku Visual Basic for Aplications 
(VBA) , ugrađena je da bi korisnik mogao da programira AutoCAD. 

Zbog svega toga AutoCAD je postao najfleksibilniji program za crtanje, 
primjenljiv u svim oblastima rada. Pored engleskog, AutoCAD podržava mnoge druge 
jezike, uključujući i pojedina nelatinična pisma, tako da AutoCAD gotovo da nema 
ozbiljne konkurencije. Dovoljno je reći da se AutoCAD koristi u svim oblastima crtanja u 
više od 150 zemalja svijeta. 

Glavne oblasti u kojima se koristi AutoCAD jesu: 

� arhitektura, inžinjering i građevinarstvo (AEC) 
� mašinstvo 
� geografski informacioni sistemi (GIS) 
� ispitivanje terena i građevinarstvo 
� održavanje objekata 
� elektrotehnika / elektronika 
� multimedija 

Takođe AutoCAD se koristi i u nekim manje vaznim oblastima kao sto su pravljenje 
uzoraka za tkanine, izrada znakova i sl. 

Pokretanje AutoCAD-a 

     Da bi pokrenuli AutoCAD potrebno je da ga instaliramo. Nakon instaliranja 
programa dobija se prečica na radnoj površini. Program se takođe može pokrenuti i 
pomoću odabira Start ►Programs ►Autodesk ►AutoCAD ►AutoCAD 2006.  
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Interfejs AutoCAD-a 

Na slici ispod je prikazan prozor AutoCAD-a odmah po otvaranju programa. 

 

Prvi Crtež 

Da bismo započeli crtanje moramo da znamo da AutoCAD sadrži bilinearni i 
trilinearni koordinatni sistem. Crtanje u bilinearnom koordinatnom sistemu se odvija tako 
što unosimo koordinate jednu po jednu. Prva se unosi vrijednost koordinate X, zatim se 
ovaja zarezom i unosi se vrijednost Y ose - sve bez razmaka. 

Snimanje dokumenata 

 Kada ste završili sa radom ili želite da ga snimite dovedite kursor miša na liniju 
menija i izaberite opciju File, zatim  izaberite opciju Save as upisite ime crteža u File 
name, i izaberite gdje želite da sačuvate vaš rad. Kada ste sve ovo obavili stisnite opciju 
Save i vaš rad će biti sačuvan na lokaciji koju ste prethodno odabrali. 

 
  Poglavlje 2 : Otvaranje crteža 

Izrada novog crteža na osnovu šablona  

Šablon je posebna datoteka koja sadrži postavke i najčešće objekte. Kada koristite 
šablon kao osnovu za nov crtež, crtež preuzima sve postavke i objekte koje sadrži šablon. 
Šabloni služe za izbjegavanje ponovnog crtanja i precrtavanja objekata u novim crtežima.  
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Da biste napravili nov crtež na osnovu postojećeg šablona izaberite File ►New. 
Otvoriće se dijalog okvir Select Template. AutoCAD će prikazati sve postojeće šablone. 
Pošto se AutoCAD otvara sa praznim crtežom pod imenom Drawing1.dwt , nov crtež 
dobija ime Draving2.dwt . Crteži koje budete naknadno otvarali biće redom numerisani. 

Rad sa šablonima  

Šablon sadrži već podešene parametre crteža, što omogućuje da odmah počnete da 
crtate. Ovi primjeri obuhvataju veličinu crteža, vrstu jedinica , itd. Osim zaglavlja šablon 
često sadrži i zaglavlje sa naslovom, odnosno okvir sa tekstom. 

napomena: Elektronski dio maturskog rada sadrži detaljno objašnjeno 
podešavanje i pravljenje sopstvenog šablona. 

Otvaranje postojećeg crteža 

     Otvaranje crteža u AutoCAD-u je kao i otvaranje bilo koje datoteke u Windowsu. 
Izaberire Open sa palete Standard. Pojaviće se okvir za dijalog Select File. Iz padajuće 
liste Look In odaberite vašu željenu datoteku. Pritisnite dugme Open. AutoCAD će 
otvoriti program. 

      Ako otvarate datoteku koja se nalazi na Webu, Pritisnite dugme Search the Web 
u okviru za dijalog. Crteže možete tražiti i u listi Places koja se nalazi s lijeve strane 
okvira za dijalog.Crtež takođe možete otvoriti ako ga kliknete dvaput u Inernet 
Explorer-u ( iako AutoCAD nije pokrenut ).Windows automatski pokreće AutoCAD i 
otvara odabrani crtež. 

Poglavlje 3: Komande 

Windows interfejs 

Tokom godina u AutoCAD-u je dodat niz novih komandi. Često su komande za 
kojima vise ne postoji potreba namjerno ostavljene zbog kompatibilnosti sa ranijim 
verzijama. U većini Windows programa sve komande su obuhvaćene menijima, ali niz 
starijih komandi kao i neke druge koje se rijetko koriste, nećete naći u menijima 
AutoCAD-a. Osim ove osobine meniji AutoCAD-a su slični menijima Windows-a. 

Priručni meniji 

Priručni meniji se pojavljuju kada pritisnete desni taster miša. 

Palete alatki 

Palete alatki vam omogućavaju da brzo zadate komande jednim pritiskom miša. 
    Sličice na dugmadima palete nisu uvijek jasne same po sebi. Auto CAD sadrži 
    30 paleta alatki a da biste prikazali ili uklonili određenu paletu pritisnite desnim 
    tasterom miša bilo koju vidljivu alatku, a zatim iz priručnog menija odaberite željenu 
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    paletu. Ako pored palete stoji kvačica onda je paleta otvorena, da biste ju zatvorili 
    ponovo je stisnite. 

 

Komandna linija 

        Imena komandi 

Svaka komanda nosi posebno ime koje se sastoji od jedne rječi. Ono ne mora da 
bude identično imenu koje se pojavljuje u okvirima s kratkim opisom ili u meniju. Ono 
što ste unijeli na komandnu liniju možete da mijenjate. Ako ste pogriješili pri unosu 
komandi jednostavno se vratite i ispravite svoju grešku kao sto to radite u programima za 
kucanje teksta (WordPad, Notepad, Word itd.). Spisak zadatih komandi možete da 
izlistate i da neke od njih ponovo upotrijebite 

O miševima i pločicama 

Za crtanje u AutoCAD-u možete koristiti mnoge dodtne pločice i grafičku tablu. 
Pločica ima nešto više dugmadi nego miš, u svom providnom dijelu ima i končanice 
pomoću kojih lakše birate tačke na crtežu na papiru. Grafička tabka ima područje koje 
odgovara površini za crtanje na ekranu monitora , kao i podesivo komandno područje 
koje korisrite za komande AutoCAD-a. Komandno područje grafičke table služi kao 
dodatni meni. 

Sistem pomoći u AutoCAD-u 

Dobijanje pomoći za aktivnu komandu 

Najlakše ćete dobiti pomoć za određenu komandu kada je započnete i stisnete F1. 
Otvoriće se prozor sa uputstvima za tu komandu. 

Kartica Index 

Ako imate samo nejasnu predstavu o tome kako se kartica zove možda će vam 
pomoći Index sistem za pomoć. Otvorite Help ►AutoCAD Help ►Index. Index 
predstavlja abecedni spisak tema za pomoć 

              Kartica Search 

Kartica Search pomaže da pronađete ključne riječi među svim rječima koje se 
pojavljuju u prozorima za pomoć. Unesite riječ u polje i stisnite List Topics. 
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Poglavlje 4: Zadavanje koordinata 

O koordinatnom sistemu  

Jedan od osnovnih postupaka u AutoCAD-u jeste zadavanje koordinatnih tačaka. 
To je osnova AutoCAD-a za crtanje, bez toga ne možete nacrtati ništa. Linije, lukove, 
krugove... , sve ovo crtate pomoću zadavanja tačaka. Kao i sve drugo u AutoCAD-u ovo 
može biti urađeno na vise načina. 

            Strelica označena slovom X pokazuje pozitivan smijer ose X. To 
znači da u tom smijeru rastu vrijednosti ose X. Strelica označena slovom 
Y pokazuje pozitivan smijer ose Y. 
            U ovom sistemu svaka tačka na ekranu određena je parom 
vrijednosti i koordinata (X,Y), a sistem se naziva  Dekartov ortogonalni 
koordinatni sistem. Koordinate ose standardno se sijeku u tački 0,0. 
Lijevo od ove tačke na osi X nalaze se njene negativne vrijednosti, a 

ispod nje su negativne vrijednosti ose Y. 

Prikazivanje koordinata 

    Tokom rada možete pogledati prikaz koordinata na statusnoj traci 

. Ovaj prikaz vam pomaže da vidite gdje se nalazi 
kursor i  objekti i daje informacije o rastojanju i o pravcu premještanja ili kopiranja 
objekata. 
        AutoCAD vam nudi tri načina za prikazivanje koordinata na ekranu: 

1. Dinamički prikaz apsolutnih koordinata: vrijednost koordinate se 
mijenja dok pomjerate miša.  

2. Statički prikaz apsolutnih koordinata: vrijednost koordinata se mijenja 
samo kada zadate tačku.  

3.  Dinamički prikaz polarnih koordinata: vrijednost koordinate se mijenja 
dok pomjerate miša. One će se pojaviti pošto zadate jednu tačku i 
spremate se zadati drugu - kao kad crtate liniju.  

        Prikazivanje koordinata možete da izmjenite na jedan od tri načina: 

1. Pritisnite taster F6.  
2. Pritisnite na statusnoj traci područje koordinata.  
3. Pritisnite tastere Ctrl+D.  

Poglavlje 5: Podešavanje parametara crteža 

Vrste mjernih jedinica  

Jedan od prvih koraka u podešavanju parametara crteža jeste izbor vrste mjernih 
jedinica. Mjerne jedinice određuju mjere objekata. Tip mjernih jedinica možete sačuvati 
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u šablonu. Koordinate s kojima radite u AutoCAD-u mjere se sa stvarnim jedinicama. 
Vrsta odabranih jedinica utiče na prikaz koordinata na statusnoj traci, kao i na to kako će 
AutoCAD bilježiti podatke o objektima. Koordinate obično unosite u jedinicama koje ste 
odabrali, mada AutoCAD prihvata i koordinate unijete u drugim vrstama jedinica. 

Podešavanje mjernih jedinica 
 
            Mjerne jedinice koje hoćete da koristite 
podešavate u okviru za dijalog Drawing Units. 
Da biste podesili jedinice odaberite  Format 
►Units, pri čemu će se otvoriti okvir za dijalog 
Drawing Units. Na lijevoj strani ovog okvira za 
dijalog možete da odaberete vrstu dužinskih 
mjernih jedinica. 

 

 
Granice crteža 

Moguće je da zadate veličinu prostora za crtanje, tzv. granice crteža. Granice su 
spoljne ivice crteža izražene tekućim jedinicama. Potrebno je zadati samo dužinu i širinu 
crteža. Ove dvije mjere formiraju nevidljiv pravougaonik koji ograničava površinu za 
crtanje. 

Umetanje naslovnog bloka 

    Naslovni blok je pravougaonik koji obuhvata prostor za naslov crteža, ime kompanije, 
ime autora crteža i sl. Najčešće se iscrtava u sklopu sa okvirom crteža. Naslovni blok 
možete da umetnete u crtež na dva načina: 

• Kada crtate nov crtež izaberite File ►New da biste otvorili okvir za 
dijalog Select Template. Izaberite šablon koji već sadrži naslovni blok. 
Npr šablon ANSI A - Named Plot Styles.dwt. već sadrži 
naslovni blok i okvir koji staje na list A4 papira.  

• Kada ste otvorili crtež u njega možete da umetnete i crtež naslovnog 
bloka. Odaberite komandu Insert ►Block. U okviru za dijalog Insert 
upišite ime crteža ili bloka, ili pritisnite Browse da biste ga pronašli.  

Uobičajeni parametri 

• Slojevi omogućavaju da crtež organizujete u grupe objekata prema 
njihovim funkcionalnim vezama. 

• Stilovi za text omogućavaju da izaberete fontove i druge osobine texta.  
• Stilovi za kote formatiraju kote kojima označavate dimenzije objekata na 

crtežu.  
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Dio II: Crtanje u dvije dimenzije 

 U ovom dijelu je objašnjeno crtanje običnih linija i krivih. Nakon toga naći ćete 
detaljno opisane postupke prikazivanja crteža. Tu su i poglavlja o radu s tekstom, 
kotiranju i definisanju stilova za kote. Ovaj dio sadrži neophodne osnovne informacije o 
crtanju i dizajniranju u dvije dimenzije. 

Poglavlje 6: Crtanje običnih linija 

Korišćenje komande LINE 

     Da biste nacrtali liniju, s palete alatki za crtanje (Draw) odaberite dugme LINE. 
na zahtjev za unos Specify first point: zadajte proizvoljnu tačku, a zatim pritisnite Enter 
da biste komandu završili. LINE spada u kontinuirane komande, što znači da komandu 
koninuirano koristite sve dok ju ne završite. 

Crtanje pravougaonika 

     Komandom RECTANG crtate pravougaonik crtajući njegove dvije dijagonale. 
Dugme Rectangle se nalazi na paleti alatki za crtanje. AutoCAD će od vas zahtjevati da 
unesete koordinate dva ugla a zatim će iscrtati pravougaonik. Koordinate možete da 
unesete bilo kojim postipkom. Npr. ako pravougaonik treba da bude širok 6 a visok 3 cm, 
drugu tačku upisujete zadavajući komandu @6,3. 

Crtanje poligona 

    AutoCAD-ovom komandim Polygon možete da nacrtate zatvoren geometrijski 
oblik s više međusobno jednakih stranica. Najpre ćete zadati broj stranica poligona a 
zatim odaberite jednu od tri metode njegovog definisanja. 
    Ako veličinu poluprečnika upišete na komandnu liniju, donja stranica poligona će biti 
horizontalna. Ukoliko tačku za poluprečnik zadajete mišem, onda možete da zadate i 
orjentaciju poligona. Kada poligon postavite na odgovarajući položaj pritisnite lijevi 
taster miša. 

Crtanje pomoću pravih 

     Komandom XLINE, pomoćna prava može se napraviti na više načina. Komandu 
započinjete birajući pomoćnu pravu (Construction LINE) sa palete alatki za crtanje. 
Ugledaćete sledeći zahtjev za unos:  
 

    Command: _xline Specify a point or [Hor/Ver/Ang/Bisect/Offset]: (zadajte tačku ili opciju...) 
 

objašnjenja ovih opcija data su u tabeli 
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                     Opcije komande XLINE 
Specify a point 

  

Ova opcija omogućava da pomoćnu pravu definišete dvijema tačkama. 
Na prvi zahtjev unosite prvu a na drugi Specify through point: unosite 
drugu tačku. 

Hor  

  

Ova opcija služi da pomoćnu pravu nacrtate paralelno sa osom X . Da 
biste to uradili na komandnu liniju ukucajte h (enter), što znači da ste 
odabrali opciju Horizontal. Zatim zadajte traženu tačku 

Ver  

  

Da biste pomoćnu pravu nacrtali paralelno sa osom Y upišite v (enter), 
što znači da ste odabrali opciju Vertical. Zatim zadajte traženu tačku. 

Ang  

  

Upišite a (enter), AutoCAD će odgovoriti zahtjevom Enter angle of xline 
(0) or [Reference]: unesite ugao zatim definišite tačku na pravoj. 

Biscet  

  

Da biste konstuisali simetralu ugla upišite b (enter), AutoCAD će 
odgovoriti zahtjevom Specify angle vertex point: odberite bilo koju tačku 
kroz koju treba da prolazi pomoćna prava, zatim na zahtjev Specify angle 
start point: odaberite tačku koja definiše jedan krak ugla. Na zhtjev Specify 
angle end point: unesite tačku koja definiše drugi krak ugla. 

Offset  

  

Da biste pomoćnu pravu nacrtali paralelno sa postojećom pravom upišite 
o (enter). Vrijednost pomaka možete da upišete kao broj ili da pomoću 
opcije Through odaberete tačku kroz koju pomoćna prava treba da proazi. 
Pošto definišete pomak moraćete da odaberete liniju, ako ste pomak 
definisali brojem na zahtjev odgovorite birajući tačku s jedne ili s druge 
strane odabrane linije. 

 

  Poglavlje 7: Crtanje krivih linija 

Krugovi 

     U AutoCAD-u krug možete da nacrtate na 5 načina. Ako želite da nacrtate krug 
odaberite Circle sa palete alatki za crtanje. AutoCAD će odgovoriti zahtjevom za unos 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: . 

Lukovi 

    Da biste nacrtali luk, sa palete alatki za crtanje odaberite ARC, a zatim pratite 
zahtjeve za unos. Kao i za krugove i za lukove često se koriste OSNAP markeri. 

Elipse i eliptični lukovi 

   Da biste nacrtali elipsu na paleti alatki odaberite Ellipse. Pored informacija koje će 
AutoCAD tražiti da unesete treba da znate i ugao - nagib prve ose koju definišete.  
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  Poglavlje 8: Prikazivanje crteža 

Načini prikazivanja crteža 

AutoCAD je vektorski program što znači da podatke o objektima čuva u obliku 
koordinata i jednačina. Kada prikazujete crtež AutoCAD pretvara vektorske podatke u 
piksele. Ovaj proces se naziva regeneracija. Tokom otvaranja crteža na komandnom 
prozoru možete primjetiti poruku : Regenerating model. 

Regenerisanje cijelog crteža može da potraje. Da bi se izbjeglo regenerisanje 
svaki put AutoCAD u memoriji računara čuva virtuelni ekran. AutoCAD ne mora ponovo 
da regeneriše cijeli crtež - on će ga samo ponovo iscrtati, odnosno osvježiti. Precrtavanje 
crteža je brže od regenerisanja. 

Pomjeranje crteža 

     Komandom PAN crtež se pomjera u zadam smijeru i zadato rastojanje se ne 
mijenja. Kada crtež pomjerate pokretanjem kursora pomjeranje se izvodi u realnom 
vremenu. Kada hoćete da pomjerite crtež, sa standardne palete odaberite Pan Realtime. 
    Da biste izašli iz režima pritisnite Esc, taster Enter ili započnite bilo koju drugu 
komandu. 

Komanda Zoom 

     Komanda ZOOM omogućava da crtež približavate (uvećavate) i udaljavate, kao 
objektivom za zumiranje.  Kada zumirate u realnom vremenu, crtež će se uvećavati ili 
smanjivati u zavisnosti od pomjeranja kursora. 

• Ako hoćete da povećavate crtež, pritisnite taster miša i pomjerajte kursor 
naviše. 

• Crtež će se smanjivati ako pritisnete taster miša i pomjerate kursor naniže. 

Izometrijsko crtanje 

Izometrijskim crtanje se postiže trodimenzionalan utisak objekata nacrtanih u 
ravni. Umjesto kvadrata koji predstavljaju strane kocke crtaju se paralelogrami, što kocki 
daje prostornu dimenziju. 

            Izometrijske ravni 

AutoCAD koristi komandu ISOPLANE da bi končice rotirao za ugao koji je 
potreban za izometrijsko crtanje. Zatim se redom prebacujete iz jedne u drugu 
izometrijsku ravan da biste u njima crtali. 
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  Poglavlje 9: Osnovne alatke za uređivanje crteža 

Uređivanje crteža 

            Brisanje objekata (Erase) 

     Brisanje objekata je veoma jednostavno. Kada selektujete objekat pritisnite desni 
taster zatim opciju CUT i objekat će nestati. 

 Premještanje objekata (Move) 

     Objekte po crtežu možete da premještate komandom MOVE. Objekat se prvo 
izabere pa se onda pomjera 

Rotiranje objekata (Rotate Object) 

      AutoCAD omogućuje lako rotiranje objekata oko zadate bazne tačke. Rotaciju 
određuje njen ugao. 

 Kopiranje objekata (Copy Object) 

     Komandom Copy se kopiraju objekti ili njihovi djelovi 

 

Biranje objekata 

Ako odaberete komandu za uređivanje objekata AutoCAD će odgovoriti 
zahtjevom Select Objects: . Ovaj zahtjev za unos sadrži 16 opcija - sve što bi vam ikad 
moglo zatrebati pri biranju objekata.  

napomena : Da biste započeli neku od narednih komandi upisite veliko slovo iz imena a 
zatim pritisnite Enter. 

    -    navedeni su samo oni najvažniji 

            Windov (prozor) 
Opcija Windov omogućuje da odaberete objekte pomoću pravougaonika. 

            Last (poslednji) 
Opcijom Last birate objekat koji je poslednji napravljen. 
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Crossing (presjek) 
Opcija Crossing omogućuje da zadate dva dijagonalna ugla pravougaonog prozora za 
izbor. 

            ALL (sve) 
    Opcijom ALL biraju se svi objekti na odmrznutim slojevima crteža. 

            Fence (izlomljena linija) 
    Opcija Fence omogućuje da preko crteža povučete izlomljenu liniju, pri čemu će 
AutoCAD odabrati sve objekte koje linija presjeca. 

            WPoligon (poligonalni prozor) 
    Opcija Windov Poligon slična je opciji Windov, osim što je prozor za izbor poligon , 
a ne pravougaonik. 

            Remove (poništavanje izbora) 
    Ovom opcijom poništavate izbor objekata. 

            Add (dodavanje objekata) 
    Upotrebite ovu opciju poslije opcije Remove da biste ponovi mogli da birate objekte. 

            Undo (poništi) 
    Ova opcija poništava izbor jednog ili više objekata odabranih u poslednjem zahtjevu. 
 

Poglavlje 10: Složenije alatke za uređivanje crteža 

Komande za premještanje i kopiranje objekata 

     MIRROR - Da biste dobili simetričan odraz jednog ili više objekata, izaberite 
objekat, a zatim na paleti alatki za mjenjanje objekta pritisnite dugme za simetrično 
preslikavanje. Redoslijed postupka možete obrnuti. 

     ARRAY - Ova komanda formira pravougaonu ili kružnu matricu kopiranjem 
jednig ili više izabranih objekata zadani broj puta. Ova komanda štedi vrijeme jer se njom 
brzo može napraviti dosta objekata. 

     CHAMFFER - Komanda Chamffer pravi zarubljen spoj između dvije 
neparalelne linije. Zarubljivanje se izvodi u dvije faze. Najprije definišite kako želite da 
obavite zarubljivanje. Zatim odaberite dvije linije čiji presjek treba zarubiti. 

     REVCLOUD - Neki korisnici obilježavaju djelove crteža koji sadrže revizije da 
bi na njih privukli pažnju. Uobičajeno je da se oblačić crta oko izmjenjenih objekata. 
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  Poglavlje 11: Organizovanje crteža pomoću slojeva, boja i linija 

Slojevi 

Slojevi imaju svojstva pomoću kojih pravite jasnu razliku između pojedinih 
elemenata crteža. Pomoću slojeva najbolje ćete organizovati boje, vrste i debljine linija 
na crtežu. 

     Da biste napravili nov sloj na paleti alatki Layers izaberite Layer Properties 
Manager. Pomoću ovog okvira za dijalog možete da napravite nove slojeve i da 
podešavate postojeće. 

Mjenjanje boje, vrste i debljine linija objekata 

Tri svojstva slojeva - boju, debljinu i vrstu linija - možete 
direktno da dodjelite objektima tako da svi objekti koje budete 
crtali imaju ova svojstva, bez obzira na svojstva slojeva na kojima 
se nalaze. 

            Mjenjanje boje objekata 

    Boju objekta možete da izmjenite služeći se padajućom listom 
boja na paleti properties. Kada napravite sloj, dodjelite mu boju i 
nastavite da crtate na tom sloju, AutoCAD će boju tog sloja na 

listi prikazati pod imenom ByLayer. 

Stavka ByLayer znači da je boja preuzeta od sloja na kome se objekat nalazi. Boja 
ByBlock stvara objekte koristeći boju 7 ( bjela ili crna ), ali ako se objekti postave u blok, 
blok preuzima tekuću boju prilikom ubacivanja u crtež. 

  
Poglavlje 12: Rad s tekstom 

Pisanje jednorednog teksta 

Jednoredni tekst koristite kada svaki red teksta treba da bude zaseban objekat ili 
kada unosite kraći tekst. Lako je napraviti jedan red teksta standardnog fonta, standardne 
visine slova itd. 

Poravnanje jednorednog teksta 

Kada odredite početnu tačku za ispisivanje teksta, odnos između nje i teksta 
određen je poravnanjem. Početna tačka se naziva i tačka umetanja. Tekst se standardno 
poravnava po lijevoj ivici, međutim to se može mjenjati. 
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Unošenje specjalnih znakova i formatiranje 

Komanda DTEXT ne podržava istu vrstu opcija za formatiranje koje su na 
raspolaganju za tekst u pasusima. 

Poravnavanje teksta 

Komanda JUSTIFYTEKST omogućava da poravnate odabrane tekstualne 
objekte a da ne pomjerate tekst. 

O stilovima za tekst 

AutoCAD omogućava da napravite stilove za tekst koji će vam pružiti punu 
kontrolu nad vrstom fonta, njegovim stilom, širinom slova, njegovim nagibom. Tekst 
možete da pišete izvrnuto, naopako i vertikalno. 
            Da biste definisali nov stil za tekst, odaberite Format ►Text Style, čime ćete 
započeti komandu Style i otvoriti okvir za dijalog Text Style. 
 

 Poglavlje 13: Kotiranje 

Kote su važan dio većine crteža u AutoCAD-u. One prikaziju veličinu modela koji ste 
projektovali i neophodne su za proces njegove realizacije. Kotiranje u AutoCAD-u pruža 
mnogo slobode. 

AutoCAD-ovo kotiranje 

 Kota je objekat koji ima više djelova. Važno je da shvatite ove djelove i njihov 
odnos prema objektu koji kotirate 

Prije nego što počnete da 
kotirate crtež uradite sledeće: 

1. Napravite poseban sloj 
za kote. Njihova boja 
treba da se ističe u 
odnosu na boju objekta. 

2. Napravite stil za kotni 
tekst. 

3. Iz menija izaberite Tools 
►Drafting Settings 
►Object Snap i 
odaberite stalne Osnap 
markere. Pritisnite 
dugme Osnap. 
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Zadavanje objekata za kotiranje 

     Paleta alatki za kotiranje naziva se Dimension, sa te palete odaberite Linear 
Dimension. Ako kotirate više od jednog objekta, npr. razdaljinu od krajnje tačke jedne 
linije do krajnje tačke druge – izaberite početak prve pomoćne linije. Na zahtjev za unos: 
Specify secondextension line origin: , izaberite tačku kao početak druge pomoćne linije. Ove 
dvije tačke će odrediti dužinu kote. 
 

  Poglavlje 14: Crtanje složenih objekata 

Polinije su jedinstveni objekti koji se sastoje od kombinacije pravolinijskih segmenata i 
lukova. Krive su geometrijski oblici nastali na osnovu tačaka koje zadajete 

Crtanje i obrada polinija 

 Polinije dobijate komandama RECTANG i POLYGON. One su veoma korisne i 
u 3D crtanju. 

 Komanda PLINE 

     Da biste nacrtali poliniju sa palete alatki Draw odaberite Polyline. Time 
započinjete komandu PLINE. Slično komandi LINE , i komanda PLINE neprekidno 
nudi da zadajete nove tačke ponavljajući isti zahtjev za unos. Kada završite crtež 
pritisnite Enter da biste završili komandu. 

 Komanda SPLINE 

     Komandom SPLINE crtate glatku krivu liniju. Pokretanjem alata dobićete zahtjev 
za unos prve tačke. Ako izaberete tačku, AutoCAD će prikazati zahjev za unos naredne 
tačke. Nakon druge tačke možete da nastavite unos ili da izaberete jednu od ponuđenih 
opcija. 

Pravljenje regiona 

 Regioni su dvdimenzionalne površine, ali iz njih AutoCAD može da izvuče više 
podataka nego iz polinija, npr. podatke o težištu. Za formiranje regiona možete da 
upotrebite ploinije, zatvorene krive, krugove itd. 

     Da biste napravili region, odaberite alatku Region sa palete Draw. AutoCAD će 
tražiti da odaberete objekte . Odaberite sve objekte i pritisnite Enter da biste biranje 
završili. Ako odabrani objekti obrazuju zatvorenu konturu koja ne presjeca samu sebe, 
AutoCAD će vas o tome izvjestiti. 
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  Poglavlje 15: Štampanje crteža na štampaču 

Kada dovršite crtež, obično se nađe još nekoliko detalja koje treba dotjerati. Ukoliko 
crtež niste započeli blokom zaglavlja sada to možete učiniti. U slučaju da crtež ima 
slojeve kojima nije mjesto na štampanom primjerku sada je trenutak da ih zamrznete, 
isključite ili onemogućite njihovo štampanje. 

Raspored elemenata crteža u okruženju za štampanje 

 Okruženje za štampanje Layout je jezičak koji se nalazi pri dnu vaše stranice. 
Ako pripremite više kartica Layout moći ćete da odštampate isto toliko različitih 
varijanata crteža. 

Rad sa stilovima štampanja 

 Stil štampanja je svojstvo objekta kao i boja, vrsta i debljina linija ili sloj. Pomoću 
stilova štampanja isti crtež ili list možete da odštampate na više različitih načina. Stilovi 
štampanja imaju i mogućnost da bolje iskoriste novije mogućnosti štampača ili plotera, 
kao što su ušteda tonera pri štampanju i korekcija boje dodavanjem međutonova. Kada ih 
nema objekti se štampaju shodno sopstvenim svojstvima. 

Štampanje crteža 

 Kada završite organizovanje crteža i formiranje lista za štampanje, spremni ste da 
odštampate crtež.  

     Da biste otpočeli štampanje sa standardne palete alatki odaberite alatku Plot 
otvoriće se okvir za dijalog Plot. Kada podesite sve opcije kako vama odgovaraju 
pritisnite OK i vaš crtež će se odštampati. 
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Dio III: Crtanje u tri dimenzije 

  Poglavlje 16: Zadavanje 3D koordinata 

Rad s 3D koordinatama 

 Kao što crtate liniju sa svojim koordinatama početne tačke 3,4 i krajnje tačke 5,7, 
isto tako možete da nacrtate i 3D liniju zadavanjjem koordinata 3,4,2 i 5,7,6. Apsolutne 
koordinate su iste u 3D – samo je dodata Z koordinata. Na isti način se zadaju i relativne 
koordinate. 

Izdizanje i zadavanje debljine 

 Žičani modeli imaju brojna ograničenja. Npr. na stolici nacrtanoj u jednoj od vježbi 
vidite nogu stolice kroz njeno sjedište. Formiranje 
detalja može da bude dosadno i dugotrajno ako 
koristite brojne pojedinačne linije ili 3D polinije. 

 Upotreba komande HIDE 

 Ova komanda omogućava pojedinim 
dijelovima žičanih modela da budu skriveni da ne bi 
dolazilo do slučajeva kao sa gore navedenim slučajem 
kod ove stolice. Ova komanda čini da žičani modeli 
izgledaju kao objekti sa debljinom. 

 

 

Rad s korisničkim koordinatnim sistemom (UCS) 

 Osim u izradi nekoliko punih tjela, rad u 3D većinom počinje u 2D obliku. 
Komandama za crtanje u 2D mogu se formirati objekti samo u ravni XY ili paralelno s 
njom. 

  Poglavlje 17: Posmatranje 3D crteža 

Dok radite u tri dimenzije možete koristiti sve poznate 2D tehnike da biste razgledali svoj 
objekat. 

Standardne tačke posmatranja 

 AutoCAD nudi 10 standardih tačaka posmatranja na potpaleti View. Ove tačke se 
najčešće koriste zato što se najlakše upotrebljavaju. Takođe možete odabrati View ►3D 
Views, a zatim posebnu tačku posmatranja iz podmenjija. 
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Standardne tačke posmatranja su : 
 pogled odozgo, odozdo, slijeva, zdesna, sprijeda, otpozadi, izometrijski, 
izometrijski SE, izometrijski NE, izometrijski NW. 

3D Orbita 

 Da biste pokrenuli 3D orbitu, odaberite View 3D Orbit. 3D Orbita ima četri 
kursora koja utiču na rad rotacije modela. Svaki kursor je zasnovan na položaju u odnosu 
na orbitalu. Pomoću 3D Orbitale vaš objekat možete rotirati u svim pravcma. 

 

 Vraćanje prethodnog prikaza 

 Kada radite u 3D orbiti možete lako da izgubite mogućnost lakog vraćanja objekta 
u prvobitni položaj. Ukoliko vam se to dogodi pritisnite desni taster miša i odaberite 
Reset View i vaš objekat će biti vraćen u prvobitni položaj. 

 
  Poglavlje 18: Formiranje 3D površi 

Crtanje površi pomoću komande 3DFACE 

     Da biste formirali 3D ravnu površinu, odaberite 3DFACE s palet Surfaces. 
AutoCAD podstavlja zahtjev za unos prve, druge, treće i četvrte tačke. Morate zadavati 
tačke u smjeru kretanja kazaljke na satu ili obtnuto, ali nikako u cik-cak kao što zahtjeva 
komanda 2DSOLID. 
 U 3D ctržma možete upotrebiti i regione. Bez obzira na to što su regioni 2D 
objekti i ne mogu imati debljinu, kada upotrebite komandu HIDE AutoCAD ih prikazuje 
kao površ. Kada je crtež regenerisan da prikaže žičani model, regioni se ponovo 
prikazuju kao žičana mreža, gubeći osobine površi. Komanda 3DFACE formira trostrane 
ili četverostrane površi koje mogu da budu u bilo kojoj ravni. 
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  Poglavlje 19: Crtanje punih tjela i dorada objekata u 3D 

Crtanje standardnih oblika 

 Crtanje kvadrata 

     Da biste nacrtali kvadrat odaberite alatku Box sa palete alatki Solids. Ako zadate 
centar kocke ne zaboravite da se koordinate Z tačaka i centara razlikuju. 

 Crtanje lopte 

     Da biste nacrtali loptu odaberite Sphere sa palete alatki Solids. Nakon zadavanja 
centra zadajete pluprečnik. 

 Crtanje kupe 

     Kupu crtate pomoću alatke Cone. Kupa može da ima kružnu ili eliptičnu osnovu. 
Zadavenjem negativne visine formirate obrnutu kupu. 

 

Crtanje obrnutih tjela 

 Komanda REVOLVE formira puna tjela od zatvorenih profila. Možete obrtati 
zatvorene 2D polinije , krugove, elipse, zatvorene krive i regione ali samo po jedan 
objekat. 
 Sistemska promjenljiva DELOBJ određuje da li će originalni objekti biti 
obrisani. Podrazumijevana vrijednost je 1. Podesite DELOBJ na nulu da zadržite 
originalne objekte. 
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  Poglavlje 20: Rasterizovanje 3D crteža 

Rasterizovanje je mnogo kvalitetniji način prikazivanja crteža od sijenčenja. AutoCAD 
nudi tri vrste rasterizovanja – Render, Photo Real i Photo Raytrace. 

 Render je originalna AutoCAD-ova alatka za rasterizovanje. Pruža njmanje 
opcija ali daje najbrže rezultate. Za rasterizovanje crteža pomoću standardno 
namještenim parametrima odaberite alatku Render sa istoimene palete. 

 

 Photo Real formira slike liniju po liniju, prikazuje bitmapirane slike, formira 
providne materijale i daje voluminozne i mapirane sjenke. 

 Photo Raytrace prati zrake svjetla da formira odsjaje i prelamanja svjetlosti, kao 
i precizne sjenke. 

 

 

 Kada rasterizujete crtež, može se dogoditi da se prozor Render ponovo otvori, 
minimiziran. 
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Dio IV: Organizovanje crteža i rad s njima 

  Poglavlje 21: Rad sa crtežima 

Pristup dijelovima crteža pomoću DesignCentra 

    Pomoću DesignCentra možete da prevučete imenovane komponente iz jednog 
crteža u drugi. Ovaj sadržaj crteža možete da pokupite sa svog hard diska ili sa inteneta. 
Sa DesignCentrom nećete morati ponovo da ih pravite. 

  Poglavlje 22: Izlazak na internet 

Slanje crteža elektronskom poštom 

 Crtež šaljte elektronskom poštom iz programa za elektronsku poštu. Primalac 
poruke otvara prilog pri čemu se automatski pokreće AutoCAD. Da biste započeli slanje 
izaberite File ►eTransmit, otvoriće vam se okvir za dijalogCrteate Transmittal, sa 
otvorenom karticom General. U odjeljku Notes možete da dodate napomenu primaocu 
poruke. 
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  Zaključak 

 Pri izradi ovog maturskog rada opredjelio sam se za program AutoCAD iz više 
razloga. Međutim faktor koji je najviše uticao je velika popularnost koju je AutoCAD  
stekao među dizajnerima i projektantima. Pri izradi ovog maturskog rada uvidio sam 
veliku opširnost AutoCAD-a i zbog toga se na ovom radu nalaze samo najpotrebnija 
objašnjenja alata, koja omogućavaju minimalan rad, međutim uz njihovo pažljivo 
sagledavanje bićete spremni i za prosječne radove. Crtanje je podjeljeno na 2D 
(dvodimenzionalno) i 3D (trodimenzonalno). Zbog svoje opširnosti 3D crtanje je manje 
obrađeno u odnosu na 2D, ali daje osnove onome ko želi da se ozbiljnije bavi crtanjem i 
modeliranjem u AutoCAD-u. 2D Crtanje se danas veoma malo koristi u AutoCAD-u 
međutim ono je osnova 3D crtanja, zbog toga što sve 2D alate primjenjujete na 3D 
crtanju, samo u drugačojem obliku. AutoCAD je planetarno najpopularniji program za 
crtanje na računaru – tome u prilog ide i brojka od 3 miliona njegovih korisnika. 
AutoCAD se koristi u svim oblastima crtanja. Ono što treba istaći je da AutoCAD služi 
za pravljenje statičnih 3D modela, a ne za pravljenje 3D animacija. Još jedna prednost u 
odnosu na druge 3D programe je to što je AutoCAD preporučen od strane vodećih 
softverskih kuća ( Microsoft, Dell, Apple ) kao najkompatabilniji program za 3D crtanje 
na njihovim operativnim sistemima.  
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